
SAW: Writing Tools 

 1 Rev. Date:  7/31/18 

Student Achievement Workshop 

(Technology Series) 

 

Writing Tools:  
Making the most of 

Microsoft Word and  

Other Word Processing Programs 
Formatting Tips for Great Papers 

 

 

 

 

Student Achievement Workshop Series 
Academic Support and Achievement Center 

Mt. San Antonio College 

6-101 
 



SAW: Writing Tools 

 2 Rev. Date:  7/31/18 

 

 

Overview: 
Make writing your research papers easier by learning how to automatically format your 

documents to MLA, APA or other format standards in MS Word and other popular word 

processing software programs.  

 

Learning Outcomes: 
Students will: 

• Discover a few formatting features in Word and other word processing programs to help 

with writing papers 

• Identify options students have for using MS Word  

• Find resources to help them become proficient with MS Word 

• Find resources for help with writing assignments 

 

What is Microsoft Word? 
Microsoft Word is simply the most common and well-known word processing software that 

allows you to type professional documents. It is a powerful tool and has many features that allow 

you to do a lot with your documents. It is one of several programs offered in the Microsoft 

Office suite of programs. 

https://support.office.com/en-us/article/create-a-document-in-word-2016-aafc163a-3a06-45a9-

b451-cb7250dcbaa1?wt.mc_id=otc_word&ui=en-US&rs=en-US&ad=US 

 

Formatting Essentials 
The following are just a small number of formatting options available to you. These are 

presented because they will likely be the most needed for students to help them become efficient 

in formatting their class documents.  For help with additional formatting topics, refer below to 

“Getting More Help”. 

 

These formatting tips can help you be efficient in writing long papers. The longer the document, 

the more challenging it is to manage and to make it look professional. Using these formatting 

tools will make your documents look and behave the way you want them to.  

 

These tools listed are from Microsoft Word. However, you may be using another word 

processing program, such as Google Docs. The good news is that it is not hard to translate this 

information to another software program because learning a second software program is like 

learning to drive a new car:  The hard part actually learning to drive. Learning a new car just 

means learning how to find and work things like the lights, blinkers, and wiper blades, etc. 

Different software titles that do the same thing, are like that. If you understand what the tool does 

and how to use it, finding it on another software program is usually very easy. 

 

Margins:  
The margins function allows you to quickly and easily set the outside margins for the 

entire document. The most common is one inch on all sides. However, based on the style 

https://support.office.com/en-us/article/create-a-document-in-word-2016-aafc163a-3a06-45a9-b451-cb7250dcbaa1?wt.mc_id=otc_word&ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/create-a-document-in-word-2016-aafc163a-3a06-45a9-b451-cb7250dcbaa1?wt.mc_id=otc_word&ui=en-US&rs=en-US&ad=US
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(MLA, APA, Turabian, etc.) you are directed to use, may determine the exact margins 

you need to use.  Consult with the guide for your style to determine actual margins. The 

“Margins” function can be found in the “Layout” tab of the Word menu bar. 

 

Headers & Footers 
Headers and footers are consistent ‘banners’ that run across the top or bottom of every 

page. Many styles require specific headers such as your last name, page number and 

document title.  Check out the style manual for the specific style formatting you need to 

use.  This formatting tool can be found in the “Insert” tab of the Word menu bar. 

 

Citations  
Reference tools, such as creating a table of contents, inserting your sources, creating a 

works cited list can be automatically formatted in word so that you only need to enter the 

information once, then place the appropriate command in the right place, and then allow 

those references to update and move with your text automatically. This is especially 

useful for creating tables of contents and works cited list.  Another great feature is that 

you can tell the system which formatting style (MLA, APA, Turabian, etc.) to use and it 

will automatically bold, italicize, underline according to the formatting style standards. 

These tools can be found in the “References” tab in the of the Word menu bar. 

 

Breaks 
You can format your document to change to new pages with ‘breaks’. There are two 

primary types of page breaks you should be aware of.  ‘Page breaks’ should be used 

when you want to start a new page even when the text does not fill the page. When 

people don’t know about page breaks, they use the ‘return’ key repeatedly to force the 

document to go to a new page. Instead, just put in a page break command. Another type 

of break to know about is the ‘Section break’ These breaks are used when you need to 

change formatting styles, such as creating a title sheet and a works cited page. The break 

tools can be found in the “Layout” tab in the Word menu bar.  

 

Writing Resources 
If you need help in writing, revising, editing, or formatting your paper, there are several in 

person and online resources that can help you.  

 

Mt. SAC  
If you need help writing revising or editing your paper, Mt. SAC has several resources to 

help. 

 

Academic Support Center (formerly Learning Assistance Center)  
The ASC offers one-on-one tutoring and workshops to help students address specific 

academic questions they may have. 

http://www.mtsac.edu/lac/docs/StudentAchievementWorkshopCalendar.pdf  

 

http://www.mtsac.edu/lac/docs/StudentAchievementWorkshopCalendar.pdf
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The Tutoring Center  
Mt. SAC’s Tutoring Center offers tutoring in all subjects, including help with writing 

assignments. http://www.mtsac.edu/lac/types_of_tutoring.html#writingtutoring  

 

The Writing Center 
The Writing Center is another campus resource that is devoted to helping students with 

their writing assignments.  http://www.mtsac.edu/writingcenter/tutoring.html  

Online 
APA Style – Video Tutorials 
The following are step-by-step video tutorials for formatting according to the APA style 

in Word.   

APA Style | Part 1: Formatting 

https://www.youtube.com/watch?v=LBMcOGGTZYM 

APA Style | Part 2: Quoting 

https://www.youtube.com/watch?v=do921cAEL6o 

APA Style | Part 3: Citations 

https://www.youtube.com/watch?v=0rDSQmO0Skw  

 

OWL 
A great online resource to with several resources for writing is the Purdue Online Writing 

Lab.  

https://owl.english.purdue.edu/owl/ 

 

How-to-study.org 
This resource has many articles on study tips, including writing papers.  

www.howtostudy.org 

 

Where to Access MS Word 
As a student at Mt. SAC, you have several ways to access the various MS Office programs.  You 

can access it through the portal, go to a campus computer lab, you can install the software on 

your device, or you can subscribe to it online. 

 

Mt. SAC Portal 
Faculty, students and staff can access a free online version of MS Office (including Word) 

through the Mt. SAC Portal.  The link is in the upper right-hand corner of the main page once 

you log in. It is the first link, “Office 365”. 

 

The portal also offers access to Google Docs as well. To access the Google Suite of software 

packages, open the “Mountie Mail” link which will take you to Gmail.  Once you are in Gmail, 

there is a grid-icon in the upper right corner of your screen. Click on that icon to access Google 

Apps. Google Docs is one of the apps available. Click on the link to access it.  

 

http://www.mtsac.edu/lac/types_of_tutoring.html#writingtutoring
http://www.mtsac.edu/writingcenter/tutoring.html
https://www.youtube.com/watch?v=LBMcOGGTZYM
https://www.youtube.com/watch?v=do921cAEL6o
https://www.youtube.com/watch?v=0rDSQmO0Skw
https://owl.english.purdue.edu/owl/
http://www.howtostudy.org/
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Campus Computer Labs 
If you don’t have a computer, or a specific software program to get your school work done, you 

can always go to one of the campus computer labs (see below) and use their software programs 

for free. Usually, you will only pay for any printing you do.   

 

Buy Software to Install (or Download) on Your Computer 
You can make a one-time purchase of the software to install onto your computer or device.  

Purchase prices can vary greatly, costing up to $500 for the whole package. Fortunately, as a 

community college student, you have access to greatly discounted prices through 

CollegeBuys.org (see below).  You can get a complete copy of Microsoft Office for about 

$40.00. You can also buy the software at your local retail store, or directly from Microsoft Office 

website.  

 

Subscribe to Cloud-based MS Office 
Individuals can just pay a low monthly fee to use Microsoft Office and its programs such as 

Word.  The following link gives information about your subscription options.  

https://products.office.com/en-us/compare-all-microsoft-office-products?tab=2 

 

If you want more information, about the difference between MS Office 2016 and MS Office 365 

you can learn more. The following link has a great in-depth comparison between Office 2016 

(installed) and Office 365 (subscription). 

https://support.office.com/en-us/article/what-s-the-difference-between-office-365-and-office-

2016-ed447ebf-6060-46f9-9e90-a239bd27eb96?ui=en-US&rs=en-US&ad=US 

 

Get the Apps 
Microsoft Office does not have its own app, but each of the individual programs can be 

downloaded to your mobile device.  If you want to download the individual apps then go to your 

app store on your phone and type in the name of the program. You should be able to find a link 

for those products.  

 

Getting More Help 
Do you still need more help? 

 

Computer Lab Technician 
Still need help with Microsoft Office?  Come to the Learning Lab (computer lab room) in 

Building 6, Room 101 and ask a technician for individualized help.   

 

Campus Help Desk 
If you still need more help, you can contact the Mt. SAC Help Desk at (909) 274-4357. 

http://www.mtsac.edu/it/  

 

https://products.office.com/en-us/compare-all-microsoft-office-products?tab=2
https://support.office.com/en-us/article/what-s-the-difference-between-office-365-and-office-2016-ed447ebf-6060-46f9-9e90-a239bd27eb96?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/what-s-the-difference-between-office-365-and-office-2016-ed447ebf-6060-46f9-9e90-a239bd27eb96?ui=en-US&rs=en-US&ad=US
http://www.mtsac.edu/it/


SAW: Writing Tools 

 6 Rev. Date:  7/31/18 

Take a Class 
If you want more detailed proficiency in Microsoft Office, consider taking a class here at Mt. 

SAC.  Go to the campus catalog for more information. 

http://catalog.mtsac.edu/programs/coursesaz/cisb/ 

Credit-based classes: 

• CISB 15 Microcomputer Applications 

• CISB 16 Macintosh Applications 

 

Or you can take non-credit classes: 

• VOC CPBC2 - Basic Computing - Level 2 

• VOC CSB15 - Microcomputer Applications 

 

Other Resources: 
Do you not have access to the hardware and/or software you need to get your homework done? 

Don’t stress because there is support for your technology needs.   

 

On Campus Computer Labs 
Mt. SAC has several campus computer labs where you can use their computer equipment, 

software and print your documents. Most of these resources (except printing) are free for eligible 

students to use. Be sure to bring your student ID cards because most of these labs require it to 

use their equipment.  

http://www.mtsac.edu/computerlabs/ 

 

Technology Purchase Discounts 
Need to buy technology and/or software?  CollegeBuys.org is a great resource for getting 

discounts on technology, software, and accessories.   

http://foundationccc.org/CollegeBuys 

 

Summary 
Microsoft Word is the most widely used word processing software which is usually part of is a 

suite of bundled software programs in Microsoft Office. This workshop will familiarize 

participants with a few formatting tools in Word for writing papers, and how to access help with 

buying or using MS Word, and where to go for help with writing assignments. 

 

Reflection 
What did you learn from this workshop? 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

 

How can you use this information this week? 

______________________________________________________________________________ 

______________________________________________________________________________ 

http://catalog.mtsac.edu/programs/coursesaz/cisb/
http://www.mtsac.edu/computerlabs/
http://foundationccc.org/CollegeBuys

